
GENERAL INSTRUCTIONS TO CANDIDATES 
(To be read out to the candidates before the start of the examinations.) 

This booklet contains examinations for the four subjects under Design and Technology. 
 SECTION 1. DESIGN AND TECHNOLOGY  1 hour 30 minutes 
 SECTION 2. HOME ECONOMICS   1 hour 30 minutes 
 SECTION 3. PRACTICAL SKILLS   1 hour 30 minutes 
 SECTION 4. COMPUTING    1 hour 30 minutes 

WHAT SECTIONS SHOULD YOU ANSWER? 

1. IF YOU STUDIED A COMBINATION OF ALL FOUR D&T SUBJECTS? 
 Students who have studied a combination of all the 4 subject areas under D&T must 

answer Section 1 only. 

2. IF YOU STUDIED ONE SUBJECT ONLY? (HOME ECONOMICS, PRACTICAL SKILLS OR 
COMPUTING)  

 i.  Students who have studied Home Economics only must answer Section 2 only. 
 ii.  Students who have studied Practical Skills only must answer Section 3 only. 
 iii.  Students who have studied Computing only must answer Section 4 only. 

3. IF YOU STUDIED TWO D&T SUBJECTS? 
 Students who have studied 2 D&T subjects will sit for those exams in the respective order 

of the papers as given above. 

ANSWER SHEETS 
The Answer Sheets are part of this Examination Booklet. Take out the middle pages and 
separate the Answer Sheets by tearing along the perforation. You may use the unused answer 
sheets for rough work. 

Make sure that you answer each section on the correct Answer Sheet. 

EXAMINATION TIMING 
When you are told to start, you will have 1 hour and 30 minutes to answer your first section. 
The invigilator will then tell you to stop writing and will collect all answer sheets used up to 
that time. 
Candidates who sit for only one subject may then leave the room. 
Those students taking a second D&T subject will now be told to start answering their second 
section. 
NOTE: YOU MAY NOT LEAVE THE EXAMINATION ROOM AT ANY TIME DURING THE FIRST 

PAPER. THOSE SITTING FOR A SECOND SUBJECT MAY LEAVE 30 MINUTES AFTER THE 
EXAMINATION HAS STARTED. 

DEPARTMENT OF EDUCATION 
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SECTION 1 
 

 

 

 

 

 

DESIGN AND 
TECHNOLOGY 

 
 

 

Time allowed:  
1 hour 30 minutes 

 

Candidates are advised to 
fully use the time allocated 

 

 

 

 

INSTRUCTIONS TO CANDIDATES: 

(To be read out by the external invigilator before the start of the 
examination) 

There are 36 questions in this paper. Attempt ALL questions even if 
you are not so sure of some of the answers. 

The Examination is divided into three parts: 

PART A: Multiple-Choice (Questions 1 to 20) 

PART B: Short-Answer  (Questions 21 to 35) 

PART C: Extended Response (Question 36) 

 

For each question in PART A (Questions 1 to 20) choose the best 
answer by writing the letter A or B or C or D in the space provided on 
the ANSWER SHEET. 

For each question in PART B and C (Questions 21 to 36) work out 
the answer and write the answer in the space provided on the 
ANSWER SHEET. 

 

If you find a question very difficult, do not spend too much time 
thinking about it. Leave the question out and go on with the rest of the 
paper. If you have time in the end, return to the difficult questions and 
think about them more carefully. 

Write your answers in BLUE or BLACK (pen or biro). 

If you decide to change an answer, make your correction as shown 
below so that it is clearer to the markers what your final answer is. Do 
NOT use correction fluid on your answer sheet. 

 
Hand in BOTH the Answer Sheet and the papers used for rough work 
at the end of the examination. 

Extra time will NOT be allowed to complete the examination 
under any circumstances. 

Penalty for cheating or assisting to cheat in national examinations 
is non-certification. 

 

DO NOT TURN OVER THIS PAGE AND DO NOT 
WRITE UNTIL YOU ARE TOLD TO START. 
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PART A (QUESTIONS 1 to 20) 

For Questions 1 to 20, choose the best answer by writing A or B or C or D or E in the space 
provided on your answer sheet. 

QUESTION 1 

In a design brief, sustainability is considered in the development of projects.  This sustainable 
development is best described as development that 

A. provides an organization with the competitive edge. 

B. meets the needs of the present generation and disregards the past decisions. 

C. compromises the needs of the present to ensure the needs of the future are met. 

D. meets needs of present and future generations. 

  

QUESTION 2 

‘Beef’ is a type of fresh meat sold in stores and shops. Which animal does it come from? 

A. goat B. cattle C. sheep D. deer 

 

QUESTION 3 

How many word documents are visible in the open window? 

A. 3 B. 4 C. 8 D. 11 
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QUESTION 4 

Researching and designing projects involves 

A. gathering information on the need for the commercial success of a project. 

B. investigating and analysing the nature of the target market. 

C. locating and analysing information on all aspect of a design project. 

D. making enquiries through the internet and professional design organizations. 

 

QUESTION 5 

Which of the following nutrients is used to make the protoplasm of body cells and is also made of 
simpler substances called amino acids? 

A. carbohydrates B. vitamins C. minerals D. protein  

 

QUESTION 6 

The options shown in the diagram can be found in a 
computer standard tool bar known as the 

A. File menu.  B. Edit menu. 

C. Insert menu.  D. Format menu  

 

 

 

 

 

 

 

 

 

 

 

QUESTION 7 

Fibres are classified under three main groups. They are the plant fibres, animal fibres, and man-
made fibres. Which of the following is an example of a plant fibre? 

A. wool B. nylon C. linen D. polyester  
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For questions 8 and 9 refer to the graph below, which shows project sales income for a 
product being developed in a school. 

The department head was instructed to sell the completed items at K15 each, based upon the 
directive enforced by the Board of Governors of the school. Upon completion of the project, 27 
items had been produced. 

QUESTION 8 

How many items did the school sell at sales 1? 

A. 11 B. 12 C. 13 D. 14 

 

QUESTION 9 

How many items remained unsold after the completion of sale 4? 

A. 12 B. 9 C. 6 D. 3 

 

QUESTION 10  

Refer to the information below. 

Which text alignment style was used to adjust the text below? 

 

 

 

Tom’s	   dog	   was	   killed	   by	   a	   car	   this	   morning.	   Tom	   found	   out	   about	   it	  
when	  he	  went	  to	  collect	  the	  morning	  papers.	  He	  dragged	  his	  dog	  into	  his	  
yard,	  dug	  a	  hole	  and	  buried	  it.	  
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Use the information below on fibre materials to answer questions 11 and 12. 

 I. wool strings, agave strings, tulip strings  

 II. twines strings, coconut fibres, cane plies 

 III. nylon strings, rayon strings, pandanus leaves 

 IV. bamboo plies, sago blinds, pitpit plies 

QUESTION 11  

Which list contains all the materials that could be used for the walls of houses? 

A. IV B. III C. II D. I 

 

QUESTION 12 

Which list contains all the materials that could be used to knit into bilums? 

A. IV B. III C. II D. I 

 

QUESTION 13 

In an orthographic projection, an object is drawn from three different angles.  When viewing the 
object from above, the correct name of the view will be 

A. front view B. left side view C. right side view D. plan 

 

QUESTION 14 

The parts of a timber plank labelled as R, S, T, U would, in order, be the 

 S 

 T 

 

 R U 

 

 

A. end, face, edge and thickness. B.  thickness, face, edge and end. 

C. thickness, end, face and edge.  D.  edge, end, thickness and face. 

 
 

QUESTION 15  

Which of the following pencils is the softest of all? 

A. 6B B. 5H C. 3B D. 2H 
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QUESTION 16 

Why doesn’t rain come through the fabric of an umbrella?  

Because the fibre of the fabric is 

A. closely packed and tightly woven. B. very absorbent and dries easily. 

C. non-moisture absorbent and light-weight. D. extremely strong and crease resistant. 

 

For Questions 17 to 18 refer to the features of Windows XP Screen below. 

Kila wants to print the first three pages of a 10-page document. He has entered the following 
options in the print dialogue box. 

QUESTION 17 

How many sheets of paper will be used? 

A. 9 B. 6 

C. 3 D. 1 

QUESTION 18 

How should Kila specify the page range 
for the first three pages? 

A.  1–3 B. 1 to 3 

C. 1,3 D.      1:3  

  

QUESTION 19 

What option should be selected to use the computer’s ‘Thesaurus’? 

A 

B 

C 
D 

                                                                                                                                                                                                                     

 

 

QUESTION 20 

Valerie wanted to cook some vegetables and meat in a quick and easy cooking method. What 
would be the appropriate method of cooking to be used? 

A. steaming B. boiling C. stewing D. casseroling 

 

 



SCE D&T 2010  Page 9 of 38 pages  
 

PART B: (QUESTIONS 21 to 35) 
For Questions 21 to 35, work out the answer and write it on the answer sheet. 

For question 21 and 22 refer the following fabric weaves diagrams below. 

           
  Weave I                                 Weave II      Weave III 

QUESTION 21 

Which of these weaves is known the pile weave? 
 
QUESTION 22 

Name the type of weave that the weft thread passes over one warp thread and under the next, 
continuing in this manner across the cloth. 

 

QUESTION 23 

Name the part of the computer setup labelled ‘Y’.  
 

 

 

 
 
QUESTION 24 

What computer term is used to refer to keyboards, mouses, and scanners? 

 

QUESTION 25 

What is the name of the type of milk without fat, leaving it with no vitamin A and D? 

 

QUESTION 26 

This is the main chip in the computer. It carries out instructions, performs calculations and 
manages the flow of information in a computer system. Name it. 

 
QUESTION 27 

The RAM and ROM are both types of _______________. 

Y   
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Use the illustrations below to answer questions 24, 25 and 26. 

     

 Drawing I Drawing II Drawing III 
 
QUESTION 28 

Which of the drawings is the detailed drawing of the block? 
 
QUESTION 29 

Which of the illustrations shows an oblique drawing? 
 
QUESTION 30 

The drawing that is drawn from three-equal axes would be drawing number? 
 
QUESTION 31 

Which of the following groups of food contains cereal products that are made from one type of 
cereal only. 
 Group I Group II Group III 
 Wheatmeal roasted oats Weetbix 
 Cornflour pasta  spaghetti 
 cornflakes rice  macaroni 

QUESTION 32 

Which of the following computer components is an output device? 

Hard Disk, Compact Disk, Floppy Disk, Printer 
 
QUESTION 33 

Name the table that is used to support work with all its necessary operations in woodwork. 
 
QUESTION 34 

Geraldine wanted to draw a 30° line with her T-square. What is the appropriate set square she 
needs to use? 

QUESTION 35 

Name a technique used on fabrics in the process of colouring? 
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PART C: (QUESTION 36) 5 marks 

For QUESTION 36, refer to the information below. Write the answer in the space provided 
on your answer sheet.  

 

CONSTRUCTING A SCREEN FOR PRINTING 

DESIGN BRIEF 

As your project in Design and Technology, you are required to construct a screen to print designs 
on a plain material. 

TASK 

Construct a screen that is 300 mm in length and 200 mm in width. 

CONSIDERATION AND CONSTRAINTS 

You are given a 1000 mm length of timber which is 50 mm in width and 20 mm in thickness.  

You are required to cut this timber into four pieces. Two pieces should be 300 mm in length and 
other two have to be 200 mm length. The four pieces of timber have to be nailed together with the 
200 mm pieces to be in between the ends of 300 mm pieces. You will need eight 40 mm nails to 
hold the timber pieces. A piece of screen of 440 mm in length and 340 mm in width should be 
stretched and stapled around the top of the complete screen. 

 

QUESTION 36 

The steps in the construction of the Printing screen frame are not in order. Put them into their 
correct order by writing the numbers in the correct sequence on the answer sheet. 

STEPS 

I. Nail two nails at one end of a 300 mm piece and into a 200 mm piece end grain to hold 
them together.     

II From leftover length of timber, cut two 200 mm pieces. 

III Stretch the screen on the level top of the frame and staple firmly.   

IV Out of the length of timber, cut two 300 mm pieces. 

V Do the same to the other three ends. 

 

 

 

END OF SECTION 1 
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SECTION 2 
 

 

 

 

 

 

HOME 
ECONOMICS 

 
 

 

Time allowed:  
1 hour 30 minutes 

 

Candidates are advised 
to fully use the time 

allocated 

 

 

 

 

INSTRUCTIONS TO CANDIDATES: 

(To be read out by the external invigilator before the start of the 
examination) 

There are 36 questions in this paper. Attempt ALL questions even if you 
are not so sure of some of the answers. 

The Examination is divided into three parts: 

PART A: Multiple-Choice (Questions 1 to 20) 

PART B: Short-Answer  (Questions 21 to 35) 

PART C: Extended Response (Question 36) 

 

For each question in PART A (Questions 1 to 20) choose the best answer 
by writing the letter A or B or C or D in the space provided on the 
ANSWER SHEET. 

For each question in PART B and C (Questions 21 to 36) work out the 
answer and write the answer in the space provided on the ANSWER 
SHEET. 

 

If you find a question very difficult, do not spend too much time thinking 
about it. Leave the question out and go on with the rest of the paper. If you 
have time in the end, return to the difficult questions and think about them 
more carefully. 

Write your answers in BLUE or BLACK (pen or biro). 

If you decide to change an answer, make your correction as shown below 
so that it is clearer to the markers what your final answer is. Do NOT use 
correction fluid on your answer sheet. 

 
Hand in BOTH the Answer Sheet and the papers used for rough work at 
the end of the examination. 

Extra time will NOT be allowed to complete the examination under 
any circumstances. 

Penalty for cheating or assisting to cheat in national examinations is 
non-certification. 

 

DO NOT TURN OVER THIS PAGE AND DO NOT 
WRITE UNTIL YOU ARE TOLD TO START. 
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PART A (QUESTIONS 1 to 20) 

For QUESTIONS 1-20, choose the best answer by writing A or B or C or D or E in the space 
provided on your answer sheet. 

QUESTION 1 

Which of the following is an example of a Natural Animal fibre? 

A. Nylon B. Flax C. Asbestos D. Wool 

 

QUESTION 2 

What process is clearly being illustrated in this diagram? 

A. rolling and folding B. creaming 

C. beating and whisking D. rubbing in 

 

 

 

QUESTION 3 

Towels and nappies are made from pile woven fabrics so that they can be 

A.  easily bleached and dried. B.  strong, durable and fire proof. 

C. moist-absorbent and soft D. resistant to colder climate. 

 

 QUESTION 4 

What nutrition-related disease is associated with chronic lack of iodine in the diet? 

A. Scurvy  B. Goitre  C. Beriberi D. Grille 

 

QUESTION 5 

Which symbol tells you that the garment should not be bleached? 

 

 

           A                  B                        C                    D 

 

QUESTION 6 

Sports wears and T-Shirts are less rigid and more stretchable.  They are examples of 

A. bonded fabrics. B. woven fabrics. 

C. knitted fabrics. D. non-woven fabrics. 
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QUESTION 7   

Which list contains equipment used for measuring ingredients in food preparation? 

A. Teaspoon, ½ cup, scale, jug  

B. Thermometer, strainer, tablespoon, mug 

C. Frying pan, 1 cup, temperature, broom  

D. Stove, ¾ cup, measuring jug, kettle. 

 

For Questions 8 and 9, refer to the illustration below. 

Each of the pictures illustrates a specific step in the manufacturing process for jeans.  These jeans 
are stone wash-denim, that is, they have been made from 100 percent cotton denim fabric and 
have been specifically treated to obtain the fashionable stone-wash look. 

QUESTION 8 

How many processes will the fibre go through before being woven into fabric? 

A. 2 B. 3 C. 4 D. 5 

 

QUESTION 9 

Which aspect of the process will provide information on how to take care of the jeans? 

A. stone-washing the jeans B. pressing 

C. selling the jeans D. garment labels 
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Questions 10 and 11 refer to the following information. 
 

Fibre properties 
 Cotton Wool Silk Flax Rayon Polyester Acrylic Nylon 
Absorbent **** **** **** **** ***  **  
Water repellent     ** **** *** **** 
Soft *** **** ** * *** *** *** *** 
Strong *** * *** ****  **** *** **** 
Cool ****  **** **** ** **  **** 
Warm ** **** *** **  * ****  
Windproof     **** *** *** **** 
Easy to wash *** *   ** *** *** *** 
         
Star rating system:  **** = Excellent     *** = Good     ** = Not very good     * = Poor 

QUESTION 10 

Which property makes Flax suitable for warmer climates? 

A. easy to wash B. soft C. cool D. strong 
 

QUESTION 11 

Which of the fabrics is commonly used for making tea towels, table clothes and bed sheets? 

A. wool B. cotton C. polyester D. linen 

 

QUESTION 12 

To prevent oil from spilling while deep-frying, it is best to 

A. Dry the foods before adding to the oil. 

B. Drop the foods quickly into the pot. 

C. Use wooden spoons only for stirring. 

D. Put the foods in the pot before heating the oil. 

 

QUESTION 13 

Cross-contamination is a 

A. method used to prevent food poisoning. 

B. sign of practices and attitudes that are unhygienic. 

C. transfer of harmful bacteria from one thing to other. 

D. condition by which bacterial will survive and multiply. 
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QUESTION 14 

Protein is used by the body for growth and repairing of tissues.  Which group of people below 
have a special need for protein? 

A. sports people B. growing children 

C. the elderly D. hard working farmers 

QUESTION 15 

Which method of fabric making is traditional and common in Papua New Guinea? 

A. weaving B. threading C. matting D. knitting 

QUESTION 16 

Burns and scalds are common accidents in the kitchen.  Scalds are caused by moist heat, while 
burns are caused by dry heat. 

How should a scald on the hand be treated? 

A. Break swollen blisters formed and leave open to dry. 

B. Put the hand under running water. 

C. Apply antiseptic and cover with a band aid. 

D. Apply butter to the area. 

 

QUESTION 17 

Which of the following is the best description of casseroling, a method of cooking? 

A. Food placed on a baking tray and cooked in an oven. 

B. Food placed on a rack and cooked over hot charcoal. 

C. Food placed in a dish, covered and cooked in an oven. 

D. Food covered in leaves and cooked over hot stones. 

 

QUESTION 18  

A finish applied to natural fibres to make them smoother as well as cause them to swell and 
shrink lengthways is called 

A. sanforisation. B. mercerisation. 

C. napping. D. crease resistance. 
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Questions 19 and 20 refer to the following information. 

 

Below are listed many countries whose staple food is rice. 
* Bangladesh * Dominican Republic * Korea * Panama  
* Brazil * Gambia * Liberia * Philippines 
* Burma * Guyana * Madagascar * Singapore 
* Cambodia * India * Malaysia * Surinam 
* China * Ivory Coast * Mauritius * Thailand 
* Colombia * Japan * Nepal * Vietnam 

QUESTION 19 

In which two Continents are most of these rice-eating countries located? 

A. Asia and Africa  B. North America and Africa 

C. Russia and South America D. Europe and North America 

QUESTION 20 

Which of these statements is true about rice? 

A. It originated from Scotland and has spread across the world. 

B. It is eaten in almost all parts of the world. 

C. It can be eaten using chop sticks. 

D. It is popular among the Asian people. 
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PART B: (QUESTIONS 21 to 35) 

For Questions 21 to 35, work out the answer for each question and write the answer in the 
space provided on the answer sheet. 
 

QUESTION 21 

A colander is a cooking utensil used to separate solid foods from the water after cooking.  What 
type of cooking method is this referring to? 
 

Refer to the table to answer questions 22 and 23. 

Fibres Strength Resilience Absorbency 

Wool Weak Fibre Very good due to its 
elasticity 

Very good 

Flax Very strong, much 
stronger when wet 

Creases and wrinkles badly Very absorbent 

Cotton Strong fibre Creases badly Excellent 
absorbency 

Silk Very strong Good wrinkle recovery Slow absorbency 

QUESTION 22 

Which fibre can be used to make clothes that stretch or warm clothes? 

 

QUESTION 23 

Which fibre can be mistaken for rayon unless the label on its bolt is read? 

 

QUESTION 24 

What method of cooking takes place with low heat applied for a long time? 

 

QUESTION 25 

What is the common term for wrong nutrition or wrong feeding? 

 

QUESTION 26 

What is the most common method of fabric construction? 

 

QUESTION 27 

Name the method of colouring fabric where the colours are applied onto the fabric? 
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QUESTION 28 

What type of sewing machine is shown in this picture? 

 

QUESTION 29 

What is the method of cooking shown in the illustration? 

 

 

 

 

 

QUESTION 30 

 

The diagram opposite showed a popular 
method of __________ a yarn in Papua 
New Guinea. 

 

 

 

 



SCE D&T 2010  Page 21 of 38 pages  
 
QUESTION 31 

Carbohydrate is largely obtained from staple foods eaten by people. Foods like kaukau, sago, etc 
contain a lot of carbohydrates in the form of ___________ and glucose. 

 

QUESTION 32 

The diagram below illustrates the parts of a cereal grain. 

 

 

According to the information given, it could be 
concluded that a cereal grain does not contain  

________________ in its germ. 

 

 

 

 

 

QUESTION 33 

Name the type of dyeing where the thread is coloured after spinning but before being woven or 
knitted into fabrics? 

 

QUESTION 34 

Scones and biscuits are popular examples of baked foods. Which one is made best using yeast? 

 

QUESTION 35 

What type of fibre does the microscopic view below represents? 
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PART C: (5 marks) 

For question 36 write the answer in the space provided on your answer sheet.  

 

QUESTION 36 

Here is a recipe to bake bread. 

Bread 

Ingredients:     
 4 teaspoons dried yeast  3 cups flour 
 2 teaspoons sugar  2 teaspoons salt 
 1 cup warm water  2 teaspoons margarine  

Procedural Steps 1 – 3 have been done for you. They are now in their correct order in the 
preparation for baking. But steps 4 – 8 have not been done for you so they are not in their proper 
order of preparation for baking. 

 

Rearrange the remaining steps 4 – 8, by writing them in their correct order of preparation for 
baking. 

Method: 

1.  Mix the yeast, sugar and warm water in a small jug. Allow to stand about 10 minutes until 
bubbles appear. 

2. Sift the flour and salt into a bowl. Rub in the margarine. 

3. Add the yeast liquid to the flour mixture. Stir into a soft dough. 

• Bake in a moderate oven until cooked. A loaf takes about 20 minutes. Rolls take 10 minutes. 

• Place the dough into a bowl. Cover with a damp cloth. Stand in a warm place until the 
mixture doubles in size. (This is quicker on the tropical coast than in the cooler highlands.) 

• Let the bread cool and serve it buttered with your favourite filling. 

• Knock the dough down. Shape it either into a loaf or into rolls. Place in a greased oven tin. 
Let it stand until it doubles in size again. 

• Turn onto a floured board and knead well.  

 

 

 

 

END OF SECTION 2 
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PRACTICAL 
SKILLS 

 
 

 

Time allowed:  
1 hour 30 minutes 

 

Candidates are advised 
to fully use the time 

allocated 

 

 

 

 

INSTRUCTIONS TO CANDIDATES: 

(To be read out by the external invigilator before the start of the 
examination) 

There are 36 questions in this paper. Attempt ALL questions even if you 
are not so sure of some of the answers. 

The Examination is divided into three parts: 

PART A: Multiple-Choice (Questions 1 to 20) 

PART B: Short-Answer  (Questions 21 to 35) 

PART C: Extended Response (Question 36) 

 

For each question in PART A (Questions 1 to 20) choose the best answer 
by writing the letter A or B or C or D in the space provided on the 
ANSWER SHEET. 

For each question in PART B and C (Questions 21 to 36) work out the 
answer and write the answer in the space provided on the ANSWER 
SHEET. 

 

If you find a question very difficult, do not spend too much time thinking 
about it. Leave the question out and go on with the rest of the paper. If you 
have time in the end, return to the difficult questions and think about them 
more carefully. 

Write your answers in BLUE or BLACK (pen or biro). 

If you decide to change an answer, make your correction as shown below 
so that it is clearer to the markers what your final answer is. Do NOT use 
correction fluid on your answer sheet. 

 
Hand in BOTH the Answer Sheet and the papers used for rough work at 
the end of the examination. 

Extra time will NOT be allowed to complete the examination under 
any circumstances. 

Penalty for cheating or assisting to cheat in national examinations is 
non-certification. 

 

DO NOT TURN OVER THIS PAGE AND DO NOT 
WRITE UNTIL YOU ARE TOLD TO START. 
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PART A (QUESTIONS 1 to 20) 

For each question, choose the best answer by writing A or B or C or D in the space provided 
on the ANSWER SHEET. 

QUESTION 1 

Which statement best describes the term ‘Universal Language’? 

A. Language signs used by the deaf and dumb. 

B. General signs and logos common around the world. 

C. Ability of speaking in many languages. 

D. Spoken language that is restricted to only one country. 

 

QUESTION 2 

In Technical drawing, alphabet of lines is important because 

A. we use Australian standards in constructions. 

B. there are three main types of lines. 

C. any shape or drawing is made out of lines. 

D. in dimensioning different types of lines are used. 
 

QUESTION 3 

What are the two appropriate uses of the T’ Square? 

A. For drawing vertical lines and setting papers on the drawing board. 

B. Extracts accurate drawing from sketches and squares them up. 

C. Used for drawing straight vertical and horizontal lines. 

D. Enables proper paper setting and aids accurate use of the set square. 

 

QUESTION 4 

Which of the following tools is a ‘marking gauge’? 

A.  B.  

C.  D.  
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QUESTION 5 

There are several types of planes used in woodwork with specific functions.  Which description 
below best suits the function of a trying or jointer plane? 

A. Used for smoothening in timber preparation. 

B. For planning timbers with larger and longer surface areas. 

C. For planning against the grain. 

D. Planning mainly timbers along the grain. 

 

QUESTION 6 

All types of tapes and rulers are graduated in 

A. millimetres and metres. B. centimetres and metres. 

C. millilitres and centilitres. D. millimetres and centimetres. 

 

QUESTION 7 

Which type of roof is commonly known as the ‘Double Pitched roof’? 

 

 

 

  

 

           A.                                       B.                                   C.                                    D. 

 

QUESTION 8 

  
The above diagram shows a timber defect.  The timber as shown has its face not flat but the edge 
is straight.  What is the name given to this defect or curvature? 

A. cup B. twist 

C. spring D. bow 
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For Questions 9 and 10 refer to the illustration below. 

QUESTION 9 

The diagram shows a section of a house under construction 
where timbers are all used.  What common building term is 
given to the timber labelled “X” in the diagram? 

A. pier B. floor joist 

C. stud D. bearer 

 
QUESTION 10 

What common building term is used to describe the timber labelled “Y” in the diagram? 

A. stump B. ant cap 

C. floor joist D. bearer 

 

QUESTION 11 

Machine shaped timber that is used for the external part of the house is known as 

A. fibro. B. plywood. 

C. weather board. D. particleboard. 

 

QUESTION 12 

Where would you normally see a “Rafter”? 

A. roof frame B. wall frame 

C. floor frame D. door frame 

 

QUESTION 13 

The blades of any cutting tool should be 

A. given little attention as it is not important. 

B. kept sharp all the time for use. 

C. blunt as there is little chance of cutting yourself. 

D. grinded before use every time. 

 

QUESTION 14 

Solid, heavy lines found on drawings are called 

A. dimension lines. B. centre lines. 

C. construction lines. D. visible outlines. 

X 

Y 
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QUESTION 15 

What does the diagram represent when used in a drawing? 

A. course of section plane B. centre of a circle 

C. hidden outlines D. visible outlines 

 

QUESTION 16 

Which of the lists below correctly contains the common bench tools? 

A. woodwork vice, G-clamp, bench stop and bench hook 

B. bench hook, G-clamp, try square and sliding bevel 

C. G-clamp, woodwork vice, wood file and hammer 

D. bench stop, marking gauge, rulers and nails 

 

QUESTION 17 

A tool specifically used for marking a mortise and tension joint construction is 

A. marking gauge. B. carpenters rule.  

C. mortise gauge. D. tape measure. 

 

QUESTION 18 

A job that requires a percussion tool is 

A. sawing. B. chiselling. C. marking. D. gauging. 

 

QUESTION 19 

The ideal abrasive materials for working in wet or dry conditions is 

A. glasspaper. B.  sandpaper. C. garnet paper. D. emery cloth. 

 

QUESTION 20 

The electrical tool used in the process of cutting circular holes is the 

A. electric drill. B. angle grinder. 

C. router machine. D. bench saw. 
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PART B (Questions 21 to 35) 
For each question work out the correct answer and write it in the space provided on the 
answer sheet. 

QUESTION 21 
The holding power of nails is improved by the use of the following techniques. 
Technique/Holding Power Description Example of Nail types that 

address the techniques 
I.  Ring barbs Along the nail shank Bullet head nails, spring head 

nails 
II.  Square shank section or 

twisted shank 
Shaped shank Spring head nails, square 

copper nails, cut tack nails 
III.  Skew nailing A type of nailing technique Bullet head nails 
IV.  Flat or wider nail head Shape of head or with 

additional attachment 
Flat head nails, spring head 
nails, clout nails 

V.  Clinching nailing A type of nailing technique Flat head nails 

According to the above table, which nail is likely to have the best holding power compared 
others? 

 

QUESTION 22 

What angle is used to draw all sloping lines in an isometric drawing? 

 

QUESTION 23 

The 4B pencil is not suitable to draw lines in technical drawing because its lead is too ________? 
 
QUESTION 24 

Which building member is used in the construction of a typical wall frame to prevent lateral 
forces such as winds or internal construction pressures from collapsing the wall? 

 

QUESTION 25 

The line marked X is one of the lines used in technical drawing. State the name of 
this line.  

 

QUESTION 26 

Green timber is carefully stacked in the open prepared foundations with air spaces between the 
boards to allow air to circulate freely.  This method is slow and dependent on the prevailing 
weather conditions.  The above description refers to the process of _______________ seasoning. 

QUESTION 27  

Which category of tool does a combination square come under? 

!"""
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QUESTION 28 

Veneers are produced by either slicing or peeling logs.  Which of the two methods is the most 
economical one? 

 

QUESTION 29  

The purpose of the part labelled R is to prevent___________. 

 

 

 

 

For questions 30 to 32, use the following tools. Write either I, II or III as your answer.                                     

             

                  I                                                     II                III 

QUESTION 30 

What tool is used when copying a given angle and tracing it to another piece of timber? 
 
QUESTION 31 

What tool is used for gluing two pieces of timber together without the reinforcement of nails? 

 

QUESTION 32 

What tool is used with a cutting tool to make the part labelled Z on 
coconut scraper legs?  

  
QUESTION 33 

The length of a screw is 300mm. What would be the new length of screw if the scale of 1:4 is 
used? 
 
QUESTION 34 

State the building member that is used in the construction of a typical wall frame and is positioned 
between studs, approximately in the centre of the height of the wall? 

QUESTION 35 

State one of the methods of dimensioning used in drawings? 

R

!"""""
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PART C (Question 36)  5 marks 

QUESTION 36 

Write the answer in the space provided on the ANSWER SHEET. 

Below are two similar pieces of timber labelled X and Y. Timber X was used to construct the 
rebate joint (timber Y).  

 
                                X                                                                      Y 

The steps given are not in the correct order. Re-arrange them in their correct order of construction 
and write the correct sequence of letters P, Q, R, S, T, on the answer sheet. 

P. Cut close to the line but on the waste side and chisel out the waste 

Q. Measure in from the other end the same measurement as the width 

R. Use the width of the timber to mark the cut of the rebate on one end 

S. Square all around the line to be cut, gauge the thickness of rebate and mark out the waste 

T. Mark the centre of the width, draw the curve with divider and rasp to round curve 

 
 
 
 
 
 
 
 

END OF SECTION 3 
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SECTION 4 
 

 

 

 

 

 

COMPUTING 
 
 

 

Time allowed:  
1 hour 30 minutes 

 

Candidates are advised 
to fully use the time 

allocated 

 

 

 

 

INSTRUCTIONS TO CANDIDATES: 

(To be read out by the external invigilator before the start of the 
examination) 

There are 36 questions in this paper. Attempt ALL questions even if you 
are not so sure of some of the answers. 

The Examination is divided into three parts: 

PART A: Multiple-Choice (Questions 1 to 20) 

PART B: Short-Answer  (Questions 21 to 35) 

PART C: Extended Response (Question 36) 

 

For each question in PART A (Questions 1 to 20) choose the best answer 
by writing the letter A or B or C or D in the space provided on the 
ANSWER SHEET. 

For each question in PART B and C (Questions 21 to 36) work out the 
answer and write the answer in the space provided on the ANSWER 
SHEET. 

 

If you find a question very difficult, do not spend too much time thinking 
about it. Leave the question out and go on with the rest of the paper. If you 
have time in the end, return to the difficult questions and think about them 
more carefully. 

Write your answers in BLUE or BLACK (pen or biro). 

If you decide to change an answer, make your correction as shown below 
so that it is clearer to the markers what your final answer is. Do NOT use 
correction fluid on your answer sheet. 

 
Hand in BOTH the Answer Sheet and the papers used for rough work at 
the end of the examination. 

Extra time will NOT be allowed to complete the examination under 
any circumstances. 

Penalty for cheating or assisting to cheat in national examinations is 
non-certification. 

 

DO NOT TURN OVER THIS PAGE AND DO NOT 
WRITE UNTIL YOU ARE TOLD TO START. 
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PART A  (QUESTIONS 1 TO 20) 

For each question, choose the best answer by writing A or B or C or D, etc. in the space 
provided on the ANSWER SHEET. 

QUESTION 1 

Which one of the following is a primary storage device? 

      
A. Hard Disk B. RAM C. Compact Disk D. Floppy Disk 

 

QUESTION 2 

Which one of the following can be found on the desktop? 

A. start button B. minimize button 

C. scroll bar D. menu bar 

 

QUESTION 3 

What is the appearance of the mouse pointer when it is busy working in the background? 

A.  B.  C.  D.  

 

QUESTION 4 

Which of the following buttons enlarges the applications window when clicked? 

A.   B.  C.  D.  

 

QUESTION 5 

The term used to describe all the physical components of a computer is 

A. software B. firmware C. hardware D. shareware 

 

QUESTION 6 

What instructs the physical component of the computers on what to do? 

A. software B. keyboard C. mouse  D. hardware 
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QUESTION 7 

Which list contains only the input devices? 

                                    
    Monitor                      CPU                laser printer           CD-ROM Drive              Speakers 

                                                    
Mouse         Floppy Drive                 Keyboard                   Floppy Disk                Scanner 

 
A. CPU, Floppy Disk, CD-ROM Drive B. Floppy Drive, Printer, Scanner 

C. Printer, Speakers, Monitor D. Keyboard, Mouse, Scanner 
 
QUESTION 8 

Which formatting feature changes the thickness of the letters? 

A. bold B. italic C. underline D. alignment 

 

QUESTION 9  

Justifying a paragraph means 

A. moving text. B. changing the text    

C. aligning the text. D. correcting the text. 

 

QUESTION 10 

You have typed two words together as shown 

  Computerassignment 

Which keyboard key should be pressed to separate the two words with the cursor placed between 
the ‘r’ and the ‘a’? 

           D 

A                                                         C 
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                            B  

QUESTION 11 

Where should the page numbers be placed so that they appear at the bottom of each page? 

A. in footnotes B. in the headers C. in text boxes D. in the footer  

 

QUESTION 12 

You have a document file called ‘Computer Generation’ open. Which of the following actions 
would allow the document file to be saved under another name? 

A. right click on the icon B. select Save from the File Menu 

C. select Save As from the File Menu D. use short cut keys Ctrl-S 

 

QUESTION 13 

You have selected information from the electronic encyclopaedia. Which command(s) should be 
used to place this text in a word processing document? 

A. copy and paste B. new document C. insert and save D. replace 

 

QUESTION 14 

Look at the way the word ‘computers’ has been formatted in the next line. 

Learning computers is fun 

Which of the following best describes the format of the word ‘computers’? 

A. underlined and smaller font B. larger font and in upper case 

C. bold, underlined and italic D. in italics, bold and larger font 

 

QUESTION 15 

Which image below shows the view of the above image after it has been flipped horizontally? 

A.  B.  C.  D.  

 

QUESTION 16 

The __________ allows you to organise and develop the content of the presentation. 
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A. View Pane B. Slide Sorter C. Outline Pane D. Status Bar 

QUESTION 17 

Which of the following is an example of one type of organisation chart?? 

A.  B.  C  D  

 

QUESTION 18 

The __________ tab provides a quick and easy way of creating a presentation. 

A. outline B. Auto Shapes C. Word Art D. Clip Art 

 

QUESTION 19 

You are setting the timings for a slideshow. 

 

Which slide will be on the screen for the least time? 

A. 4 B. 3 C. 2 D. 1 

 

QUESTION 20 

While typing your assignment, you noticed a green wavy line appeared in your text under several 
of the words. 

What does the green wavy line under the words indicate? 

A. The text is underlined.  

B. The text contains a spelling error. 

C. The text has been highlighted.  

D. The grammar in the text is incorrect. 
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PART B: (QUESTIONS 21 TO 35) 
For Questions 21 to 35, work out the answer for each question and write the answer in the space 
provided on the answer sheet. 
 

QUESTION 21 

Which view allows the user to specify the arrangement of placeholders in a Power point slide 
presentation? 

 

QUESTION 22 

Select the list with the correct procedures followed 
to open the above document. Write the number 
next to the list in the space provided on the 
answer sheet. 

Lists: 

I. Start > Program > Paint > Accessories 

II. Start > Accessories > Program > Paint 

III. Start > Paint > Accessories > Program 

IV. Start > Program > Accessories > Paint 
 
QUESTION 23 

Which of the following is a video file? 
Frogs.avi, Fish.png, Toads.mp4, Orchids.wav 

 
QUESTION 24 

When a document is ‘Read Only’ it cannot be changed or _____________.  

 

QUESTION 25 

Which menu option will allow a user to see how a document will look before it is printed? 

File > Print,   File > Page Setup, File > Print Preview, View > Print Layout 

 

QUESTION 26 

  
A list of commands available in a view like the one shown above is called a __________. 
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QUESTION 27 

Which keys are held down on the keyboard in order to ‘paste’ something into a document? 

 

QUESTION 28 

What key should be used create spaces between paragraphs? 

 

Questions 29 and 30 refer to the illustrations below. 

 
Figure 1   Figure 2  

In order to achieve the image shown in figure 2, figure 1 was first 

 29  and then  30 . 

QUESTION 31 

What is the name given to the picture on the screen that represents a specific file or program? 
 
QUESTION 32 

What is button clicked to make the Windows application occupy the entire screen. 
 
QUESTION 33 

What allows users to move horizontally and vertically to display the contents of a document. 
 
QUESTION 34 

What is a rectangular panel on your screen that displays information and operates a particular 
program? 
 
QUESTION 35 

What is the item that stores deleted files and allows you to recover them? 
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PART C: Question 36 – (5 marks) 

For question 36 write the answer in the space provided on your answer sheet.  

QUESTION 36 

TASK 1. Copy a whole document and paste it on a new word document. Rename the document.   

TASK 2. Insert a table with three equal width columns and five rows. Set the width of the 
columns to 30 mm. 

 

The commands to use in Task 1 and Task 2 are from the menu bar. They are not in their logical 
sequence. Re-arrange them in their logical sequence and write them down in the spaces 
provided on the answer sheet. 

 

TASK 1. 

 i. To copy a whole document  

 COMMANDS:   COPY>EDIT>SELECT ALL>EDIT 

  ii. Paste the document into a new word document 

 COMMANDS:   EDIT>NEW WORD DOCUMENT>PASTE>FILE 

 iii. Rename the document 

 COMMANDS:   SAVE AS>TYPE NEW NAME>FILE> SAVE 

TASK 2. 

 iv. Insert a table with three columns and five rows. 

 COMMANDS:   Insert Table>3>Scroll>Columns# >Rows#>Table>Scroll>5 

 v. Setting the width of the columns 

 COMMANDS:   30>OK>Scroll>Fixed Column Width 

 

 

 

 

 

 

 
 

END OF SECTION 4 
 


